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Windows 10 Support
BIOQUANT LIFE SCIENCE now supports Windows 10 and Windows 7. 

We do not officially support Windows 8. BIOQUANT will probably work, but we haven’t tested under 
Windows 8, and we haven’t created a BIOQUANT profile for the interface, so it will look crowded.  We 
recommend you upgrade to Windows 10.

The installation program auto detects your version of Windows and installs the correct BIOQUANT 
profile for the operating system.

UPGRADING TO WINDOWS 10 AFTER YOU INSTALL LIFE SCIENCE 2016

After you install this version, if you are a Windows 7 user and you click the Microsoft 
button to upgrade for free to Windows 10, contact us for directions on updating your 
BIOQUANT profile to Windows 10, as Windows does not let individual applications 
know this change has happened. 

If you don’t, it is not really a big deal. We just want to walk you through copying over a 
file that will make your BIOQUANT interface not so crowded.

If you are installing BIOQUANT on a PC that has Windows 10, and never had a 
previous version of Windows, you do not need to do this.

New Features and Enhancements

OPEN CURRENT GUIDE

The Guide region has a new feature called Open Current Guide, which opens the current guide in the 
Guide Editor and highlights the current step. 

This really speeds up editing guides on the fly. If you haven’t created custom guides for your 
protocols, give it a try. They keep you trained and on task, especially when you haven’t done a 
protocol in awhile or when you are training the new student.

Procedure:

1. In the Guide region, use the Next or Back arrows to navigate to:

• A step you want to edit

• A step you want to delete

• A step after which you want to add a new step

2. In the Guide region, from the Editor drop list, choose Open Current Guide.

The Guide Editor opens with the current guide open. The current guide step is highlighted.
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GUIDE EDITOR: CURRENT STEP TAB

The current guide step is highlighted.

3. Edit the step, delete the step, or add new steps.

4. To see your changes, click the Save button and answer “Yes” to the confirmation message.

In the Guide region, the current guide updates to match the changes. You will be on the same 
guide step that you were on when you executed Open Current Guide, unless you deleted it, then 
you will be on the next guide step.

LARGE IMAGE NAVIGATOR: CROP IMAGE

The Large Image Navigator has a new feature that lets you crop a Scan to the region you are actually 
interested in measuring. This is also useful becuse the Shrink To Fit zoom level will now be able to 
show measurement region at a high resolution.

You can crop a BIF, BMP, or TIF image. The system will crop the image to the same file type that it 
was before the crop, i.e., BIF to BIF, BMP to BMP, and TIF to TIF.

Procedure:

1. Open a large BIF, BMP, or TIF scan into the Large Image Navigator.

2. On the Large Image Navigator, click the Shrink/Expand Image button to fit the entire view in 
the Image window.

3. On the Large Image Navigator, click the Crop Image button.

The cursor enters the Image window.
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4. In the Image window, click and drag over the region you want cropped to create a rectangle.

You can repeat making the rectangle shape until it matches your requirements.

LARGE SCAN OPEN

The crop region has been defined.

5. Right click to exit the Image window.

The BQ Save Cropped Image window opens. Note that BQ Save Cropped Image will only save to 
the same file format as the original image.

6. On BQ Save Cropped Image, type a name for the cropped file and then click the Save button.

The cropped image opens. If it is larger than 1280 x 960, it opens into the Large Image 
Navigator.
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BQ SAVE CROPPED IMAGE

Type a file name for the cropped image.

CROPPED SCAN OPEN

The cropped image is now open.

LARGE IMAGE NAVIGATOR: PAN BOX SNAPS TO AUTO ROI

Using Auto ROI with the Large Image Navigator has been improved so that if you move the Pan box 
completely outside of the Tissue Volume redraw, the system now snaps the Pan box to the nearest 
field with Tissue Volume  tracing.
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WHAT IS AUTO ROI?

When measuring within a Sampling area at high mag, Auto ROI is the feature that generates the 
region of interest (ROI) for you whenever you move the Pan box in the Large Image Navigator. 

• If you move the Pan box completely within the Sampling Area tracing, the system 
changes to a Full Screen ROI. 

• If you move the Pan box so that it overlaps the Sampling Area tracing, the system 
changes to the Topo ROI and uses the Sampling area redraw visible in the Image window 
as the ROI.

• Now, if you move the Pan box completely outside of the Sampling Area, the system will 
snap the Pan box back to a field that contains Sampling Area tracing.

• To provide user feedback, the Sampling Area tracing now redraws within the Large Image 
Navigator.

WHY IS THIS COOL?

This is cool because now you can use the  Coarse Move Pan Box button to navigate through 
the Sampling Area and the Pan Box stays on fields touching or within the Sampling Area. When 
Coarse Move Pan Box reaches the end of the Sampling Area, it moves to the lower right corner 
of the Large Image Navigator and stops measuring.

In cases where you have easily thresholded cells that don’t require user interactive threshold 
editing, this means that you could use Batch Scripts to do the navigating, automatic threshold 
commands (such as Clean, Erode, Dilate), and measurement for you. See Batch Scripts in the 
Life Science Manual.

LARGE IMAGE NAVIGATOR: MEASURE CELLS PAN BOX MOVE DEFAULT

The Large Image Navigator Coarse Move Pan Box buttons now have a unique setting when used 
with Measure Cells. This allows you to set a different overlap % when you are using the Coarse Move 
buttons with Measure Cells that with the other Measurement Types.

COARSE MOVE PAN BOX BUTTONS

When using Measure Cells, you can now set a different 
image overlap with the Coarse Move buttons.
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TO CHANGE THE COARSE MOVE STEP SIZE

a. Open an image with a resolution larger than 1280 x 960 to open the Large Image 
Navigator.

b. On the Large Image Navigator box, click the  Navigator Setup button to open the 
Navigator Setup box.

c. On the Navigator Setup Box, change the Coarse Move Step (Measure Cells).

For many cell populations, the default 75% should work.

If you have larger cells, you might need to decrease the step size so that large cells won’t 
be split across the border of the image.

NAVIGATOR SETUP BOX

The default Coarse Move Step for Measure Cells is 90.

DEFAULT VALUES

• Coarse Move Step (Measure Cells): 90 
This sets the Coarse Move button setup size for the Measure Cells 
Measurement Type only.

• Coarse Move Step (% of Pan Box): 50 
This sets the Coarse Move button setup size for all Measurement Types 
besides Measure Cells.

d. When you are finished, click the OK button to close the Navigator Setup box. 

Now whenever you click on of the Coarse Move buttons, and you are using the Measure 
Cells Measurement Type, the field will move the indicated amount.

THRESHOLD REGION REDESIGN

The Threshold region has been redesigned to make room for the new Multi-Band Threshold (Beta) 
feature. All the previous Threshold features are still there, but they have been organized better. 

There is one small change.  It’s no longer possible to set the threshold range by clicking and dragging 
the RGB color indicators. To set the threshold, you still use the Select or Add buttons or the new 
Multi-Band tools. 
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THRESHOLD SCROLL WHEEL IMPROVEMENTS

Did you know that when you click Select or Add in the Threshold region, you can add threshold by 
scrolling up on the scroll wheel and subtract threshold by scrolling down?

THE WAY THRESHOLD BY SCROLL WHEEL WORKS

• Click Select or Add and then click a color in the Image to set the base RGB 
threshold range.

• Scroll up to threshold more, expanding from the initial color. 

• After you’ve scrolled up a bit, you can scroll back down to subtract threshold until 
you get back to the initial color.

We’ve improved Threshold by Scroll Wheel in the following ways: 

• Auto Generate Initial Color

Now when you click Select and enter the Image window to define a threshold, if you 
immediately scroll up, the software will pick the initial color for you based on the colors in the 
image.

Auto Generate works best on single stained slides, like TRAP.

• Better Support for Mixing Adding More Colors by Clicking and Adding Colors by Scrolling

Start with the first color. Scroll the mouse wheel to add more similar colors.

Now, click a second color. The threshold will expand to include second color. Now scrolling the 
mouse wheel will add colors similar to the expanded color range.

• Better Symmetry for Adjusting the Threshold by Scrolling Up and Down

If you scroll the wheel up a lot so that one of the R, G, B threshold values would go above 255 or 
below 0, BIOQUANT now preserves this value correctly relative to the other colors so scrolling 
back down still preserves correct relative values for R, G, and B.

MULTI-BAND THRESHOLD (BETA)

A new Multi-Band Threshold feature has been added. This feature is in the beta stage. We look 
forward to your feedback. Currently you need to use either the traditional “Single-Band” thesholding 
or the new “Multi-Band.” In future versions the two thresholding techniques may be merged into the 
standard Threshold region.
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MULTI-BAND THRESHOLD BOX

To open this box, click to check Multi-Band in the Threshold region.

Quick Feature List:

• Multi-Band Threshold lets you create one threshold that is combination of multiple thresholds.

• To open Multi-Band Threshold box, check the Multi-Band box. 

This automatically opens the Multi-Band Threshold box.

• The default view on the Multi-Band Threshold box is for MB Threshold set number 1. You can 
set up to 10 MB Thresholds at a time. To sequence between them, change the number in the MB 
Threshold drop list.

• Each MB Threshold can contain up to 5 bands. Each band can have a Red (RH, RL), Green 
(GH, GL), and Blue (BH, BL) range. The “H” indicates the High limit on the range and the “L” 
indicates the Low limit of the range.

• To set a band, in the Threshold region of the ribbon:

a. Use Select and/or Add to set the first threshold range. 

b. Then, in the Multi-Band box, next to the band you would like to set, click the Record 
button. 

c. Repeat for each band you want to assign.

d. After you have set each band, you combine them into a single threshold by clicking the 
Refresh button in the Threshold region.

• To view an individual band, click the View button next to the band. 

After you click View, you can click Add in the Threshold region to add threshold to that 
particular band. Then click Record next to the band to update the band’s threshold ranges.

• To delete an individual band, click the Delete button next to the band.

• Clean Bands will do the Editing “Clean” command between each band when Refresh is clicked 



Page 11 • BIOQUANT LIFE SCIENCE 2016 Release Notes

to combine the bands.  Clean removes small stray pixels from the threshold.

• Show Bands will display the threshold that is currently on the screen when using Select and 
Add. 

• To generate threshold on the screen, use either Refresh to combine all threshold bands, 
or use View to generate a single band. Then click Add or Select. The threshold will still be 
visible when the cursor enters the Image window.

• If Show Bands is not checked, the threshold will clear from the Image window as soon as  
Select or Add are clicked. 

• New will clear your settings and start a new Mult-band Threshold file.

• Open will let you open a MB Threshold file that has previously been saved to the Multi-Band 
Threshold folder.

• Save will save the current MB Threshold settings to a file.

Multi-Band Threshold files are saved in the BQLIFESCIENCE2016\Multi-Band Threshold folder. 
When you switch between MB Threshold numbers in the MB Threshold drop list, the system 
will require that you save the file. If you have already created a file, it will auto save to it. If you 
have never created a file, it will prompt you to create one.

• Multi-Band Thresholds can be assigned to arrays, just like Single-Band Thresholds.

• A Multi-Band Threshold (MBT) file can be assigned to the data set using Assign to Data Set. 

Then, whenever the data set is opened, the MBT file will automatically load. If the Selected 
array has a MBT assignment, the Multi-Band Threshold box will open and the assigned MB 
Threshold number will be active. See “Assign to Data Set enhancements” below.

• Selecting Arrays with Threshold Assignments:

• If you click on an array that has a traditional threshold assignment, Multi-Band will turn 
OFF and the traditional threshold will refresh.

• If you click on an array that has a multi-band threshold assignment, Multi-Band will turn 
ON, the Multi-Band Threshold box will open, and the multi-band threshold will refresh.

• Navigating to the Next Field: Current Limitation of Multi-Band Threshold

With traditional thresholding, when you navigate to the next field of view in the Large Image 
Navigator or Imaging Toolkit, the threshold automatically refreshes. Currently, with Multi-Band 
Threshold, when you navigate to a new image, you need either click Refresh in the Threshold 
region, or click the Array with the Multi-Band assignment in the Selected List to re-generate 
the Multi-Band threshold.

• For a more comprehensive procedure, see the LIFE SCIENCE Manual.



Page 12 • BIOQUANT LIFE SCIENCE 2016 Release Notes

ASSIGN TO DATA SET ENHANCEMENTS

You can now assign a Measurement Filter file, as well as a Multi-Band Threshold file, to the current 
data set using Assign to Data Set.

This saves time as you don’t have to load the Measurement Filter or Multi-Band Threshold files when 
you come into BIOQUANT LIFE SCIENCE. Also, if you use the data set as a template for another data 
set, you won’t have to load the files with the new data set. 

If you haven’t checked out assigning Selected Lists, Guides, Calculation Lists, Measurement Filters, 
and Multi-Band Threshold files to the data set, give it a try. It will save time and keep you organized!

Here is an outline of the procedure:

1. If you use Measurement Filters: 

a. Create several Measurement Filters and assign the different filters numbers to different 
arrays.

Measurement Filters can filter based on Area, Perimeter, Height, Width, Shape, X position, 
and Y position.

Use “Set Filter by Sampling” if you want the system to generate the filter for you.

See the LIFE SCIENCE Manual for more directions.

b. From the File menu on Measurement Filters, use Save As to save a file in the 
BQLIFESCIENCE2016\Measurement Filters folder. 

It is helpful to name the file the same as the data set so it is easy to find.

2. If you use Multi-Band Threshold: 

a. Create several MB Threshold sets and assign the different set numbers to different arrays.

See the LIFE SCIENCE Manual for more directions.

b. From the File menu on Multi-Band Threshold box, use Save to save a file in the 
BQLIFESCIENCE2016\Multi-Band Threshold folder. 

It is helpful to name the file the same as the data set so it is easy to find.

3. From the File menu, choose Assign to Data Set.

4. If you use Measurement Filters: 

• On the Assign to Data Set box, select the Measurement Filter file you saved in the 
Measurement Filter drop list.

Measurement Filter files located in the BQLIFESCIENCE2016\Measurement Filters folder 
are automatically listed in the Measurement Filter drop list.

5. If you use Multi-Band Threshold: 

• On the Assign to Data Set box, select the Multi-Band Threshold file you saved in the 
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Multi-Band Threshold drop list.

Multi-Band Threshold files located in the BQLIFESCIENCE2016\Multi-Band Threshold 
folder are automatically listed in the Measurement Filter drop list.

6. At this point, if you have created a Guide, Selected List, or Calculation List for this data set you 
can select them in their corresponding drop lists as well.

ASSIGN TO DATA SET

Choose items to assign to the data set from the drop lists.

7. On the Assign to Data Set box, click the OK button.

Now, if you exit BIOQUANT, when you come back in the files assigned to the data set will 
automatically be loaded. 

If you have assigned the Measurement Filter to the first array in the Selected list, the 
Filter Number assigned shows up as active (not grey) in the parenthesis next to the word 
Measurement in the Tools list.

If you have assigned the Multi-Band Threshold to the first array in the Selected list, the Multi-
Band number assigned shows up as active (not grey) in the parenthesis next to the word Multi-
Band in the Threshold region.

COMPREHENSIVE PROCEDURE

For a more comprehensive procedure, see the LIFE SCIENCE Manual.

UNDO BUTTONS NOW ON MEASUREMENT REGION

Now instead of going to the Edit menu to Undo a measurement, you can simply click the Undo button 
in the Measurement region.

Undo works with all Measurement Types.  Undo reverts the system to its state before the “Measure” 
button was clicked. Undo reverts both the morphometric and topographic data.

Here is a procedure:
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1. Make a mistake using any of the Measurement Types.

2. Click the Undo button.

AUTO WIDTH MEASUREMENT TYPE ENHANCEMENTS

The following enhancements have been made to the Auto Width Measurement Type.

1. Auto Width Measurement Type: Max Width Length parameter

To avoid issues with C and S shapes, a new Auto Width Setting has been added called “Max 
Width Length.” The default is 5000. If the width lines on C and S shapes are darting to the 
wrong surface, lengths above this value will be excluded. They will be marked with a square, but 
no line will extend from the square and no data value will be recorded.

To set the Max Width Length, in the Measurement region (Auto Width Type), click the Settings 
button. Then on the Settings box, change the Max Width Length and click OK.

2. Auto Width Measurement Type: Spacebar to End checkbox status

On the Auto Width Type, the Space to End box is now defaulted to always ON.

MINOR ENHANCEMENTS

The following minor enhancements have been added to BIOQUANT LIFE SCIENCE:

1. Open Single Image/Open Image Sequence:  

a. Opens .tiff Extension

The BQ Open Image and BQ Open Sequence boxes now list “.tiff” as well as “.tif” files.

b. Compressed TIF Error Message

BIOQUANT now gives an error message if you try to load a compressed TIF image.

2. Additive and Subtractive Mode have been removed.

Additive and Subtractive Mode were legacy features that were introduced before BIOQUANT 
has the Calculations box to total array measurements for you. They introduce issues with new 
models of measurement, so they have been removed. If you need help altering your templates  
and protocols to remove Additive and Subtractive mode, contact Technical Services.

The support menus “Increase Element: Current Array” and “Increase Element: All Selected 
Arrays” have also been removed.

3. ROI Region: The Spacebar to End checkbox has been removed

The Spacebar to End checkbox has been removed. When defining ROIs using the iROI Cursor 
or Irregular ROI Types, the Spacebar to End functionality is always ON now. You can tap the 
keyboard spacebar to end the ROI tracing definition, or simply click the right mouse button to 
exit the Image window and end the ROI tracing definition.

4. The following boxes have been renamed:
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a. Calculations box: Rename

The Calculations box has been renamed Calculate to fit within Windows 10 title bars.

b. Strut box: Rename

The Strut Analysis box has been renamed Strut to fit within Windows 10 title bars.

c. Batch Script Editor: Rename

The name of the “Batch Measurement Editor” box has been changed to “Batch Script 
Editor.”

5. Large Image Navigator: View Whole Image Removed

The View Whole Image has been removed. It was a legacy feature that no longer supports very 
large digital images.

6. Large Image Navigator: Only Shows Supported Zoom Buttons

The Large Image Navigator now only shows the zoom buttons (1:1, 1:2, 1:4, 1:8, 1:16) that are 
supported by the image size.

Imaging Extensions: Enhancements
The following enhancements have been made to the BIOQUANT Imaging Extensions add-on.

IMAGING TOOLKIT: MONTAGE UP TO 4 GB 

The Imaging Toolkit has the following enhancement:

• Montage up to 4 GB

The Imaging Toolkit can now create a montage up to 4 GB BIF image, as long as the system has 
enough resources.

SCAN: Enhancements
The following enhancements have been made to the BIOQUANT SCAN add-on.

SCAN MULTIPLE SLIDES: SET SCAN AREA BY EDGES

The scan area can now be set by marking the various edges of the area to be scanned. BIOQUANT 
will compute the necessary size and shape of the scan area. Scanning multiple slides at once is not 
supported with “Set by Edges.”

In previous versions, the only way to set the scan area for a section was to mark the center of the scan 
area and then tell BIOQUANT how big of an area to scan around the center.
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SCAN MULTIPLE SLIDES: SET BY EDGES

From the Set By drop list, choose “Edges”.

Here’s a quick procedure:

1. One microscope or BIOIMAGER, choose the objective that will be used to scan the section.

2. On Scan Multiple Slides Setup, in the Setup region, from the Set By drop list, choose “Edges”.

3. From the File Format drop list, choose the file type for the scan.

4. Enter the section ID under the diagram of the slide.

5. Move the stage to one edge of the area to be scanned.

6. Click the Set Edge button.

The computed center of the scan area will appear under the slide diagram.

7. Move to other edges of the scan area and click the Set Edge button for each edge.

As more edges are set, the center value will update. If an edge is added that was already in teh 
scan area, the center value may not need to be updated.

8. Make other setup choices and then click the OK button to close Scan Multiple Slides Setup.

BIOIMAGER ENHANCEMENT: CHANGE OBJECTIVE WITH THE MAG LIST

On the Scan menu, the Move to Next Objective and Move to Previous Objective menu items now 
change the Parameters Mag entry, as well as rotate the nosepiece to the matching objective on the 
BIOIMAGER. 

IMPORTANT CALIBRATION CHANGE

A default calibration file has been provided for the BIOIMAGER. This file is located in 
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the Calibration Backups folder.

This calibration file contains proper calibration values for the 4 default objectives on 
the BIOIMAGER: 4X, 10X, 20X, 40X.

It also contains two extra entries that represent the empty objective slots on the 
motorized nosepiece of the BIOIMAGER.

Calibrate for the objectives that are on your lab’s BIOIMAGER. If the objective set 
on your BIOIMAGER is different from the default set, be sure each position of the 
nosepiece has an entry in the Mag drop list, including any empty positions.

AUTO SEQUENTIAL IMAGING REMOVED

Now that SCAN has been improved to support setting a scan area by its edges, Auto Sequential Image 
has become obsolete. The “Auto Sequential Imaging” and the “Test Auto Sequential” tools have been 
removed. 
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